Introduction:
SolidWorks is serious about helping you get your job done faster. Continuous improvement of large assembly and drawing performance is a major focus with every software release. Through the addition of new enhancements, and the refinement of existing functionality, SolidWorks 2009 now provides unmatched large assembly and drawing performance.

About this guide:
This guide is intended to be a best practices guide for users who wish to optimize their large assembly and drawing performance. Please take the time to read all the techniques. Not all these techniques will apply to your design environment, so find the techniques that work best for you. Techniques that are recommended for everyone are noted as HIGHLY RECOMMENDED. For more details on these techniques please refer to the SolidWorks 2009 Online User’s Guide which can be accessed in SolidWorks by clicking Help.
What is a large assembly?

- A large assembly is any assembly that is complex enough to:
  - Max your system resources
  - Be a detriment to productivity

What are the signs you are having problems with a large assembly?

- A large assembly will cause performance degradation in the following areas:
  - Open and save
  - Rebuild
  - Drawing creation
  - Rotation and viewing
  - Mating

What factors affect large assembly performance?

- **General Settings** (Options)
- **Assembly Design Methodologies** (Top-Down, Bottom-Up)
- **Assemblies** (Open, mating, configurations, external references)
- **Drawings** (Lightweight or resolved, configurations, views, display quality)
- **Parts** (Sketches, external references level of detail)
- **Data Management** (Manual data management, Workgroup PDM)
- **Hardware** (CPU, memory, graphics card, OS)
- **Environment** (Network, retrieval methodology)
General Settings:

Large Assembly Mode and Lightweight Assemblies: HIGHLY RECOMMENDED

- Lightweight is an amalgamation of Options settings that result in improved performance
- Includes an option setting for triggering Lightweight assemblies (see “Assemblies” below)
- A threshold based on number of parts in the assembly can be set to trigger Large Assembly Mode
- Can be activated on the fly: **Tools > Large Assembly**

Activating Large Assembly Mode: **Tools > Large Assembly Mode**

- When activated, Large Assembly Mode makes certain Options settings un-editable (options
Some Display/Selection options greyed out (Un-editable) in Large Assembly Mode

**Large Assembly Mode Options:**
- You can change Large Assembly Mode settings: **Tools > Options > Assemblies**
- Highly recommended options are:
### Large Assembly Mode options

- Automatically load components lightweight
- Do not save auto recover info
- Hide all planes axes, sketches, curves, annotations, etc.
- Do not display edges in shaded mode

For better performance, do not display edges in shaded mode

#### Performance

- Performance related settings are found at **Tools > Options > Performance**
- "No preview during open" allows faster opening of the model but does not provide a preview – it is not controlled by Large Assembly Mode
Assembly Design Methodologies: **USE WHERE APPROPRIATE**

The modelling techniques listed below are powerful, but they have advantages and disadvantages. Make sure you use these techniques with care and only use the techniques that you feel fit your situation:

**Bottom-up Design**

Bottom-up design is the traditional method. You first design and model parts, then insert them into an assembly and use mates to position the parts. To change the parts, you must edit them individually. These changes are then seen in the assembly.

Bottom-up design is the preferred technique for previously constructed, off-the-shelf parts, or standard components like hardware, pulleys, motors, etc. These parts do not change their shape and size based on your design unless you choose a different component.

**Top-down Design**

Top-down design is also referred to as "in-context design" in the SolidWorks Help.

In Top-down design, parts' shapes, sizes, and locations can be designed in the assembly. For example: You can model a motor bracket so it is always the correct size to hold a motor, even if you move the motor. SolidWorks automatically resizes the motor bracket. This capability is particularly helpful for parts like brackets, fixtures, and housings, whose purpose is largely to hold other parts in their correct positions. You can also use top-down design on certain features (such as locating pins) of otherwise bottom-up parts.

The design of a photocopier can be laid out in a layout sketch, whose elements represent the pulleys, drums, belts, and other components of the photocopier. You create the 3D components based on this sketch. As you move or resize elements in the sketch, SolidWorks automatically moves or resizes the 3D components in the assembly. The speed and flexibility of the sketch allows you to try several versions of the design before building any 3D geometry, and to make many types of changes in one central location.

The advantage of top-down design is that much less rework is needed when design changes occur. The parts know how to update themselves based on the way you created them.

You can use top-down design techniques on certain features of a part, complete parts, or entire assemblies. In practice, designers typically use top-down techniques to lay out their assemblies.

**Assembly Layout Sketch Technique**

You can design an assembly from the top-down using layout sketches. You can construct one or more sketches showing where each assembly component belongs. Then, you can create and modify the design before you create any parts. In addition, you can use the layout sketch to make changes in the assembly at any time.

The major advantage of designing an assembly using a layout sketch is that if you change the layout sketch, the assembly and its parts are automatically updated. You can make changes quickly, and in just one place.

To use an assembly layout sketch, do the following:

- Create a **layout sketch** in the assembly in which various sketch entities represent parts in the assembly. Indicate a tentative location for each component, capturing the overall design intent.
- Reference the geometry in the layout sketch when you create each component. Use the layout sketch to define the component size, shape, and location within the assembly; make sure that each part references the layout sketch.
Creating a Part in an Assembly
You can create a new part in the context of an assembly. That way you can use the geometry of other assembly components while designing the part. The new part is saved internally in the assembly file as a virtual component. Later, you can save the part to its own part file.

You can also create a new sub-assembly in the context of the top-level assembly. See Creating a Sub-assembly in SolidWorks Help for more information.

To save a virtual component to its own external file, right-click the component and select Save Part (in External File). Alternatively, when you save the assembly, you can select to save the part either inside the assembly or to an external file.

Skeleton Part Technique
This technique is similar to the Assembly Layout Sketch technique (above) except the sketch is created at a part level rather than at the assembly level.

This technique is most effective if you want your layout sketch to be able to be inserted directly into a part or into any other assembly as a first part. Think of it as a reusable layout sketch for parts and assemblies.

- Create a part that will represent the overall simplified layout of the assembly – we call this the Skeleton part. Most time this is a 2D sketch, kind of like a cross-section of the design. It may contain sketches, planes, points, surfaces, whatever is needed to define the skeleton to the level of detail you desire. You can use Sketch Blocks functionality to more easily create the skeleton, and even create mechanisms that move to test kinematics.
- This skeleton part can then be added as the first part to any assembly, or be inserted directly into a part. Subassemblies can also use the skeleton part as the first component so that even if you open just a subassembly, you can still see and select references from the skeleton part representing the overall critical references of the entire assembly.
- Parts can be assembled to the skeleton part in the sub-assembly or at the top-level assembly.
- Skeleton parts can be filtered from the BOM so they don’t appear.

Be aware: If you create in-context references to the skeleton, or assembled pieces of a mechanism to the skeleton, you won’t be able to free-drag the components. Component position will update if the skeleton changes.

Multi-Body Technique
If you have parts in an assembly with extremely intricate part relationships (i.e. laminated wooden guitar body, mold cavity, etc.) you may consider using multi-body.

- You can “split” parts out as an assembly – the location of parts in the split assembly is automatically controlled by the multi-body part.
- Features added to the “split” parts (hole wizard holes, shell, etc.) are not sent back to the multi-body part.

Be aware: Individual parts are completely dependent on the multi-body model. Some changes to parts may have to occur in the multi-body part.
“Insert Part” or “Master Model” Technique
If you have a design with only a few intricate relationships between the parts you may opt to model only the shared geometry or references (i.e. the outer skin of a car door panel, the outside skin of the cell phone, etc.).

This technique is often used in designing consumer products, automobile bodies, and other designs design with intricate relationships among the parts and complex shape requirements. This design technique is more appropriate if you usually start your design with a surface model which represents the outside shape of the product.

- Model the surfaces, datum planes or other reference geometry that multiple parts will reference.
- Start new parts and insert this part into each model as the first feature.
- If the part inserted into the design is updated, all parts update.

Be aware: Similar to multi-body cautions. Still have an external reference to the inserted part. Changes to these features must occur in the inserted part.
Assemblies:

How assemblies work
- Assemblies solve serially in this order

Tips on “Mates”
- Mating many components to a common reference is better than “chain”
  - Example: Mate 3 screws to a flat plate – mate the bottom of the heads to the top surface of the plate rather than mating the top of screw B to the top of screw A, the top of screw C to the top of screw B, etc.)
- Mate performance in order of speed (fastest to slowest):
  - Relation Mates (Coincident, Parallel, etc.)
  - Logical Mates (Width, Cam, Gear)
  - Distance Mates
  - Limit Mates

Avoid circular references
- Most commonly occurs when mating to in-context features
- Can also occur when mating to component patterns
- Common symptom of circular references is assemblies requiring more than one rebuild
Lightweight Assemblies: HIGHLY RECOMMENDED

- You can load an assembly with its active components fully resolved or lightweight. Both parts and sub-assemblies can be lightweight.

- When a component is fully resolved, all its model data is loaded into memory.

- When a component is lightweight, only a subset of its model data is loaded in memory. The remaining model data is loaded on an as-needed basis.

- Large Assembly Mode (see “General Settings” above) can be setup so that assemblies will be automatically opened lightweight if they more than a certain number of components.

Lightweight components are displayed with a feathered icon in the FeatureManager.

- You can improve performance of large assemblies significantly by using lightweight components. Loading an assembly with lightweight components is faster than loading the same assembly with fully resolved components. Assemblies with lightweight components rebuild faster because less data is evaluated.

- Lightweight components are efficient because the model data for the components is loaded only as it is needed. Only components that are affected by changes that you make in the current editing session become fully resolved. You can perform the following assembly operations on lightweight components without resolving them:

  - Add/remove mates
  - Edge/face/component selection
  - Assembly features
  - Measure
  - Section properties
  - Mass properties
  - Exploded views
  - Physical simulation
  - Interference detection
  - Collision detection
  - Annotations
  - Dimensions
  - Assembly reference
  - Geometry
  - Section views
  - Advanced component selection
  - Advanced show/hide components

- When a component is lightweight, a feather appears on the component icon in the FeatureManager design tree.

- To enable automatic lightweight loading of components:
  - Click Tools > Options > Performance
  - Under Assemblies, select automatically load components lightweight.
  - If the previous option is not selected,
Open large assemblies Lightweight: HIGHLY RECOMMENDED

You can open an assembly in Lightweight mode

- To manually open an assembly with lightweight components:
  - Click File, Open.
  - The Open dialog box appears.
  - Select Lightweight, browse to the assembly file, and click Open.
  - All components of the assembly are loaded lightweight.

- To set one or more resolved components to lightweight:
  - For a single component, right-click the component and select Set to Lightweight.
  - For an entire assembly, right-click the top level assembly icon and select Set Resolved to Lightweight.
  - For a sub-assembly and its components, right-click the sub-assembly icon and select Set Resolved to Lightweight.

Open large assemblies using Quick View and Selective Open: HIGHLY RECOMMENDED

- “File – Open – Quick View/Selective Open” allows you to open specific components of an assembly without bringing all the other components into memory
- The components in the assembly remember their mates so that components move relative to each other even when components are missing from session
- You can select components to open by clicking on individual components, by using a 2D pick box or by using the 3D “Volume Select” functionality found under the Select fly out found in the Standard toolbar.
- The “Show Hidden Components” icon found in the Assembly toolbar allows you to toggle on hidden components for selection
- A Display State of the assembly, in this state, can be saved and reused
Opening Design Tree only

**Open a Display State of an assembly:** HIGHLY RECOMMENDED

- You can open a Display State of an assembly and either hide components or not load them into memory
- “File – Open” and select the Display State and check/uncheck “Do not load hidden components”

**Use Sub-assemblies:** HIGHLY RECOMMENDED

- Use sub-assemblies - avoid flat structures with lots of mates
  - With subassemblies, only sub-assemblies that need updating will update
  - If the assembly is flat, with no sub-assemblies, all the mates for all the parts have to update
  - If you want to show motion in a subassembly you can make it a flexible subassembly

**Use Configurations of assemblies where appropriate:**

- Assembly configurations allows you to suppress parts and substitute “simplified” configurations of parts for more complex finished models
- By suppressing parts and features more RAM is freed up
- **Note:** Use configurations if you are going to keep the configuration simplified at this level of the assembly or if it is for design purposes (a new design configuration) – don’t use configurations to simply Hide/Show parts because configurations ALWAYS rebuild – see “Display States” below if you simply want to hide and show many parts with one pick
- When simplifying parts be sure you are not suppressing surfaces that are needed for mates
• Assembly level configurations give SolidWorks the flexibility to control:
  o Part level configurations
  o Part Suppression
  o Part Visibility
  o Suppression state of mates
  o Modification of assembly features
  o Suppression of component patterns
  o Configuration specific properties
  o Values of distance & angle mates

• Always open the assembly with the correct configuration active to save time – don’t have to switch to the desired configuration

Use Display States where appropriate: HIGHLY RECOMMENDED
• Display states NEVER require a rebuild, Configurations ALWAYS rebuild
• Note: For Hide/Show and advanced visualization, use Display states - to show different versions of a design, use Configurations
• Display States can be made independent of configurations if desired
• Controls:
  o Part visibility
  o Display mode
  o Texture
  o Transparency

Example of Display State
**Use Isolate:**
- Use **Isolate** to quickly hide all but selected components
- Temporary setting which allows easier selection and model manipulation

Isolate can be used to quickly hide all parts except those selected

**Fix missing/broken references:**
- Ensures assembly accuracy and speeds rebuilds

**Electrical Routing:**
- Route from connector to connector, not pin to pin
- Show pin-to-pin info in a table on the harness drawing
Working with Large Configurations:

- Feed “heavy” configurations while working in “lighter” configurations
- Do this by making heavy configurations inactive, but set Properties to accept new components, their mates, etc.

Make heavy configurations inactive, work in lighter configurations

Hole Series:

- Use Hole Series to create holes in multiple parts and automatically add fastener stacks (i.e. bolts, washers, nuts, etc)
- **Insert > Assembly Feature > Hole > Hole Series**
- Guarantees holes will line up and correct fasteners will be added to holes
- Hole show up at part level
- Fastener selection based on Hole Wizard
- BOM will be accurate with correct fasteners
- **Be aware:** Creates external reference because a hole sketch point is created
Lock External References:

- Locking external references prevents a rebuild because of an external reference
- It’s best to decide if you want external references up front

You can decide up front if you want to create external references or not
By using the option “Do not create references external to the model”

External references can be viewed, broken and locked
Suspension automatic rebuilds:

- You can defer the update of assemblies until you are ready to rebuild the assembly. By deferring the update, you can make many changes, and then rebuild the assembly all at once. The assembly still rebuilds automatically, if necessary, for internal updates and to protect the integrity of the model.
- **Be aware:** Use this option only when absolutely necessary. Rebuild errors created while this option is active will not become apparent until this option is deactivated (or you do a manual rebuild), which can make it difficult to determine the cause of the errors.
- To defer the update of assemblies:
  - Right-click the assembly name at the top of the FeatureManager design tree, and select Suspend Automatic Rebuild.
  - (Rebuild Suspended) appears in the status bar.
- To manually update when in Suspend Automatic Rebuild mode:
  - Click Rebuild on the Standard toolbar.
- To turn off the option:
  - Right-click the assembly name at the top of the FeatureManager design tree, and clear Suspend Automatic Rebuild.
- You must reset the option every time you load the assembly document.
Drawings:

**Lightweight Drawings: HIGHLY RECOMMENDED**
- Lightweight drawings are analogous to lightweight assemblies. When a drawing is lightweight, only a subset of its model data is loaded in memory. The remaining model data is loaded as needed.
- Performance of drawings of large assemblies is improved significantly with lightweight drawings. Loading a lightweight drawing is faster than loading the same drawing with fully resolved parts.
- Lightweight drawings are efficient because the full model data is loaded only as it is needed.
- To load a drawing as lightweight:
  - When you open a drawing, select Lightweight in the Open dialog box.
- To set assembly components to lightweight or resolved:
  - Right-click a component and select Set to Lightweight or Set to Resolved.
- When a component is lightweight, a feather appears on the part icon in the FeatureManager design tree.
- To set drawing views to lightweight or resolved:
  - Right-click a drawing view and select Set Resolved to Lightweight or Set Lightweight to Resolved.
  - A feather in the FeatureManager design tree also indicates lightweight views.
- Detached drawings cannot be lightweight drawings.
- With lightweight drawings, you can:
  - Create all types of drawing views
  - Attach annotations to models in views
  - Dimension models in views
  - Specify edge properties
  - Select edges and vertices
  - Set drawings of sub-assemblies to lightweight or resolved
- If you print a lightweight drawing when it is out of synchronization with its model, the drawing prints with a watermark:
  - SolidWorks Lightweight drawing - Out-of-Date Print

**Other Drawing Tips:**
- Always use High Quality views
- Use shaded views to layout drawings
  - Modify System settings to reflect this: Tools > Options > Display Style > Shaded
Use shaded views when laying out a drawing - faster

- Use configurations to minimize un-necessary detail in drawings
  - Can switch configurations later
- Using less views per sheet is better
  - Use multiple sheets or drawings instead
- Only update individual views
- If you use configurations and you can still preserve BOM numbering
  - If you use configurations and suppress you can retain the numbering

Using configurations you can suppress or retain the numbering of BOM

- **IMPORTANT:** Sensible use of configurations, section views, detail views and alternate position views
  - The more configurations a drawing references, the more time to update a drawing – be careful in the number of configurations a particular drawing references
  - SolidWorks has to touch, rebuild and store in memory each configuration to keep the drawing up to date
  - Configurations, sections, detail and alternate position views are essentially “new models” in the drawing environment
- **Tip:** Sensible use of total numbers of sheets
  - consider breaking down dozens of sheets to multiple files
- Check for interferences before making HLR drawing views
  - Ambiguity into what’s displayed, not displayed affects drawing view creation time
Parts:

**Modelling techniques:**
- Fully define your sketches – they will solve faster
- Resolve rebuild errors
- Do not model threads unless absolutely necessary!
  - Use cosmetic thread if visual effect needed
  - Model only functional threads (i.e. Archimedes screw, screw feeds, etc.) if absolutely necessary – even then, suppress them in the top level assembly if possible
- Avoid using text for features - instead use a sketch or draw simplified letters
- Minimize unnecessary detail - use sketch entities

Don’t create features for unnecessary details

- Use different templates to store Document Settings for particular components
  - Speed up interference checking by using templates to store “IsFastener” which designates component as a fastener for interference checks – it will ignore the interference created by the fact that the thread is a cylinder

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Type</th>
<th>Value / Text Expression</th>
<th>Evaluated Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Number</td>
<td>Text</td>
<td>WA000943</td>
<td>WA000943</td>
</tr>
<tr>
<td>2 mxc_dim_type</td>
<td>Text</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>3 mxc_dim_val</td>
<td>Text</td>
<td>0A</td>
<td>0A</td>
</tr>
<tr>
<td>4 Description</td>
<td>Text</td>
<td>RB SMCS-560-L3 X 1.500</td>
<td>RB SMCS, 560-L3 X 1.500</td>
</tr>
<tr>
<td>5 mxc_ext</td>
<td>Text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 mxc_ext2</td>
<td>Text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 mxc_metal</td>
<td>Text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 mxc_pos_x</td>
<td>Text</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 IsFastener</td>
<td>Yes or no</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Setting the “IsFastener” property
• Fillets
  o If possible, add fillets last and suppress when not necessary
  o Combine same size fillets into one feature

• Patterns
  o Avoid showing large or complex patterns at top level assembly (i.e. fill pattern)
  o Try “Geometry pattern” option when creating a pattern – it’s faster upon regeneration

• Springs
  o Do not model spring details and avoid modeling helices – use a cylinder to represent the spring

• Imported geometry
  o When using FeatureWorks, only create features on parts if necessary – leave as imported geometry if SolidWorks features are not necessary
  o When possible, make sure all imported geometry is fully knitted to create a solid
  o Model appropriate assemblies as parts rather than as assemblies (i.e. bearings) – you can use “SaveAs Part”
Data Management:

**Why it’s important to use Workgroup PDM or Enterprise when working with large assemblies:**

- Most often used in a multi-user environment
- Data policeman
  - A PDM system manages who has control of files for modification
  - Prevents over-writing and losing data
- Revision control
  - Controls the revision level of files
  - Knows the correct revision level of all the components of a particular revision of an assembly or drawing
- Controls access to the design
- PDM knows when a part is changed
  - Even in-context changes you may not normally pick up manually
  - A PDM system makes a top-down design technique much easier to use in a team environment
  - Inadvertent changes are made evident by warnings (i.e. trying to change read-only files)
- Brings files to your local drive so you can open locally – faster than running over the network when SolidWorks needs to open configurations or resolve components from lightweight

**Workgroup PDM vs. Enterprise PDM:**

- Workgroup PDM
  - Usually up to 10 users
  - Designs that require sharing of components
  - Revision control
- Enterprise PDM
  - Usually 10+ Users
  - Everything PDMWork Workgroup does plus:
    - Multi-site capable
    - Workflow capable

**Other Tools for Finding and Managing Design Data:**

- SolidWorks Search
  - Easier way to find and open files
  - Single tool to search everywhere for files, including in PDM
  - Can search on metadata (properties)
- Pack and Go
  - **File > Pack and Go**
  - A great tool for organizing your files to send to customers and vendors
  - Create a .zip file or saves to a new folder
  - Automatically saves all the referenced part, assemblies, etc.
Tools for Checking Design Data:

- **Utilities – Compare Geometry**
  - Let’s you compare changes to part geometry and features easily
  - Graphically displays differences

- **SolidWorks Design Checker**
  - Verify company standards have been met
  - Learn from an existing drawing
  - Auto correction of checks
  - Spell check
  - Check for non-standard hole sizes
  - Automation with SolidWorks Task Scheduler
Hardware:

Where do I find hardware requirements for running SolidWorks?

- Hardware requirements are listed on the SolidWorks Customer Portal under System Requirements

RAM:

- The most important requirement for handling large assemblies is having enough RAM
- If you don’t have enough you will be paging with large assemblies (swapping RAM to disk)

32 bit or 64 bit machine?

- 32 bit machines have a 2Gb RAM size limit – once exceeded, you will be swapping to disk, which is much slower
- the main reason to go to 64bit machines (and 64bit OS) is for more memory
- 64 bit machines will be faster for assemblies that exceed the 2Gb limit of the 32 bit systems
- For very large models that exceed the 2Gb size limit of the 32 bit architecture we recommend an X64 processor with 6GB or more

Virtual memory:

- Virtual memory is recommended to be 2X the amount of RAM

Multi-Core and Multi CPU's:

- Faster, unless of course you need the memory
- Some aspects of SolidWorks are multi-threaded, dual core takes advantage of this
  - PhotoWorks
  - Cosmos
  - File translation
  - Hidden Line Removal

Video Card

- Special graphics card requirements if you want to use RealView graphics – please consult on-line technical support info on graphics cards
- Effects rotating and spinning, zooming and panning
- Recommended: A certified OpenGL workstation graphics card and driver
- Check the SolidWorks Customer Portal under Hardware and Graphics for certified cards
- Tip: If your assemblies are running close to your max available RAM, then a lower level graphics card would be better because a 512Mb card will map to 512Mb of RAM

Defrag

- Run defrag regularly
- Do not unfrag as SolidWorks uses some of the data stripped by these utilities

Service Packs - Stay current on service packs:

- Lots of errors can be tracked down to different versions of service packs for both OS and SolidWorks

Network:

- Should all be 100Mb or 1Gb and be separated from other network traffic by a gateway
**Environment:**

**File location:** VERY IMPORTANT

- #1 performance factor is where the parts are located
- Files should be local for best performance
- If you must get parts from the network (usually a multi-user environment where data is shared) then use Workgroup PDM
  - Workgroup PDM will create a local copy of the file that can be managed for change - the benefit of Workgroup PDM is that only those parts that have changed are copied over
  - If the files are local then SolidWorks need only read the configurations for the current configuration of the assembly
  - If the parts are located anywhere other than the local drive, the entire file will be copied across to a temporary location (current session only) before the necessary configurations are read

- **Search Routine for Referenced Documents**
  - **Note:** The more search paths the software has to traverse to locate documents on the network, the slower the overall performance. This is most evident when opening files, saving files, changing configurations, setting Lightweight to Resolved - any operation that needs to access additional information from disk.
  - When opening a referenced document, SolidWorks performs a search to locate the document. For example, this search may occur when you open a drawing and the referenced assembly cannot be found or when you resolve a lightweight component in an assembly
  - When a referenced document is found, the software updates the path to the referenced document in the parent document. When you save the parent document, the updated path is saved as well.
  - The Rules column below describes the search routine that the software uses to locate a missing referenced document.
  - The Examples column shows the paths that the software checks using the following scenario:
    - The assembly was last saved as C:\zz\a1.sldasm. You move the assembly to D:\ss\tt\a1.sldasm.
    - The first part in the assembly was last saved as C:\qq\p1.sldprt. You do not move this part.
    - The second part in the assembly was last saved as C:\zz\yy\xx\p2.sldprt. This part is missing either through deletion, renaming, or some other file management mistake.
    - There are two paths in the Folders list of the File Locations Options dialog box: D:\aa\bb\ and E:\cc\dd\.
    - You click File, Open to open a1.sldasm in its new location.
## Rules

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Uses any open document with the same name.</td>
<td>If p2.sldprt is in another open document, SolidWorks uses this version of p2.sldprt.</td>
</tr>
<tr>
<td>2. Searches the first path that you specify in the <strong>Folders</strong> list in the <strong>File Locations Options</strong> dialog box.</td>
<td>D:\aa\bb\p2.sldprt</td>
</tr>
<tr>
<td><strong>NOTE</strong>: You must select the <strong>Search file locations for external references</strong> check box in the <strong>External References Options</strong> dialog box or else SolidWorks ignores the paths that you specify.</td>
<td></td>
</tr>
<tr>
<td>3. Searches the path in Step 2 plus the last folder in the path where the referenced document was last saved.</td>
<td>D:\aa\bb\xx\p2.sldprt</td>
</tr>
<tr>
<td>4. Searches the path in Step 2 plus the last two folders in the path where the referenced document was last saved.</td>
<td>D:\aa\bb\yy\xx\p2.sldprt</td>
</tr>
<tr>
<td>5. Repeats Step 4 until the full original path has been appended to the path in Step 2.</td>
<td>D:\aa\bb\zz\yy\xx\p2.sldprt</td>
</tr>
<tr>
<td><strong>NOTE</strong>: This concept of adding one folder at a time from the full path will be called &quot;recursive searching&quot; in the following steps.</td>
<td></td>
</tr>
</tbody>
</table>
| 6. Recursively searches the first path in the **Folders** list, and then recursively searches the path where the referenced document was last saved. | D:\aa\xx\p2.sldprt  
D:\aa\yy\xx\p2.sldprt  
D:\aa\zz\yy\xx\p2.sldprt  
D:\xx\p2.sldprt  
D:\yy\xx\p2.sldprt  
D:\zz\yy\xx\p2.sldprt |
| 7. Repeats Steps 2 through 6 for the other folders in the **Folders** list. | E:\cc\dd\p2.sldprt  
E:\cc\dd\xx\p2.sldprt  
E:\cc\dd\yy\xx\p2.sldprt  
E:\cc\dd\zz\yy\xx\p2.sldprt  
E:\cc\yy\xx\p2.sldprt  
E:\cc\zz\yy\xx\p2.sldprt  
E:\xx\p2.sldprt  
E:\yy\xx\p2.sldprt  
E:\zz\yy\xx\p2.sldprt |
8. Searches the path of the active document, then recursively searches the path where the referenced document was last saved.

<table>
<thead>
<tr>
<th>Path Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>D:\ss\tt\p2.sldprt</td>
</tr>
<tr>
<td>D:\ss\tt\xx\p2.sldprt</td>
</tr>
<tr>
<td>D:\ss\tt\yy\xx\p2.sldprt</td>
</tr>
<tr>
<td>D:\ss\tt\zz\yy\xx\p2.sldprt</td>
</tr>
<tr>
<td>D:\xx\p2.sldprt</td>
</tr>
<tr>
<td>D:\yy\xx\p2.sldprt</td>
</tr>
<tr>
<td>D:\zz\yy\xx\p2.sldprt</td>
</tr>
</tbody>
</table>

9. Searches the path where you last opened a document, then recursively searches the path where the referenced document was last saved.

**NOTE:** In most cases, the path of the active document and the path where you last opened a document are the same. The two paths are different if you click **File, Open** to open one document, then drag and drop an assembly from Windows Explorer into that document. The path of the active document is the path from Windows Explorer and the path where you last opened is the same as Step 8.

10. Searches the path where the software last found a referenced document.

<table>
<thead>
<tr>
<th>Path Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\qq\p2.sldprt</td>
</tr>
</tbody>
</table>

This is the location of p1.sldprt.

11. Searches the full path where the document was last saved without a drive designation.

<table>
<thead>
<tr>
<th>Path Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is useful if you save a part with a UNC path such as \machine\folder\p2.sldprt</td>
</tr>
</tbody>
</table>

12. Searches the full path where the document was last saved with its original drive designation.

<table>
<thead>
<tr>
<th>Path Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\zz\yy\xx\p2.sldprt</td>
</tr>
</tbody>
</table>

13. Allows you to browse for the document yourself.

<table>
<thead>
<tr>
<th>Path Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
</tr>
</tbody>
</table>

Journal File:
- Make sure the journal file is local, you don’t want to be writing a journal file over the network
- You can set journal file location with: **Tools > Options > File Locations**

Backup/recover:
- For fastest performance, turn this off
- If you really want back-ups, make